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1. General 

HERMES is the remote data transfer program for DIA.NE XT / WIN. It provides both customers and 
GE Jenbacher service engineers with a powerful tool for the remote control and maintenance of 
GE Jenbacher engines and plants. When developing the program, the main design prerequisite was that 
HERMES should comply with all functionalities of DIA.NE XT / WIN, the leading engine management 
system on the gas engine market. Thanks to HERMES all on-site functionalities can now also be 
accessed through remote control. Apart from that, DIA.NE remote message control (RMC) enables the 
automated transmission of messages and data to RDT (Remote Data Transmission) control centres. The 
concept ensures that the hierarchical information compression approach upon which DIA.NE XT / WIN is 
based, will be consistently followed in accordance with the "automation pyramid". 
 
HERMES therefore consists of: 
 
2 applications 
•  DIA.NE WIN 
•  DIA.NE RMC (remote message control) 
 
3 connection options 
•  Modem (analogue, ISDN, GSM) 
•  Network (LAN) 
•  Internet 
 
which can be supplied in any combination customers may require. 
However, at least 1 connection option and 1 application must be ordered. 
 

1.1 Construction 
Each engine (module) is provided with a powerful control and visualisation unit (DIA.NE XT), which is 
responsible for the direct control of the engine. All modules are linked through a network connection using 
100BaseT Ethernet. Up to 16 modules (+A1 through +A16) can be linked to a DIA.NE WIN server (+Z1) 
via this network. Any number of clients (DIA.NE WIN client, RDT control centre – but only up to a 
maximum of 5 clients at the same time) can communicate with this computer, which is usually not 
equipped with a display, via various connections.  If required, a station control unit for the entire plant can 
be integrated into the network. 
 
 
The following illustration shows the configuration. 
 
The Internet range is shown in simplified form. The exact diagram is at the end of the document. For 
more detailed information, please contact the GE Jenbacher Competence Centre. 
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2. Applications 

2.1 Remote control (operating and monitoring) with DIA.NE WIN 
The plant is remotely operated by a web-based application (DIA.NE WIN). 
 
A separate set of online documentation has been written for DIA.NE WIN, describing both the operation 
and the installation of the DIA.NE WIN client. 
The configuration of the network connection between the DIA.NE WIN client and the DIA.NE WIN server 
via the various connection options (modem, LAN, Internet) is described in the section containing the 
Installation instructions – Configuration instructions. 
 

 
 

2.2 Automatic data and message transmission through DIA.NE remote message control 
The DIA.NE RMC software package contains an automated facility for transmitting data and messages 
from DIA.NE WIN servers to RDT control centres and forwards them by fax, e-mail and SMS (via an e-
mail SMS gateway). The messages and data stored in a RDT control centre can be randomly accessed 
for processing by any workstation connected to this unit via a LAN. 
 
In line with the tasks described above, the DIA.NE RMC software package is divided into the following 
three programs: 
 
DIA.NE message 
Once classified, the data on the individual modules generated in DIA.NE XT are transmitted to one or 
more RDT control centres. 
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DIA.NE control 
In the RDT control centre all incoming messages are monitored and, after again being classified, they are 
forwarded to an external communication participant. 
 
DIA.NE report 
The received data can also be accessed (View, Print) by all users via a network (LAN) connected to the 
RDT control centre. 
 
In a RDT control centre, standard modem/LAN/Internet-equipped PCs are used to connect to any of the 
DIA.NE WIN servers. The service engineers also have the option of forwarding the data and messages to 
certain fax numbers and/or, using Internet access, to certain e-mail addresses. Messages can also be 
forwarded to mobile phones and pagers via an e-mail SMS gateway. 
 
 

2.3 DIA.NE control 
In the RDT control centres, DIA.NE control takes care of receiving and archiving all incoming messages 
and data. DIA.NE control also forwards messages and reports via fax and e-mail (incl. SMS for mobile 
phones and pagers) to notify service staff.  
 
The allocation of DIA.NE WIN servers to the RDT control centres is not pre-configured. In principle, any 
DIA.NE WIN server can send messages and data to any RDT control centre. 
 

2.3.1 Receiving messages and data 
DIA.NE message places a call to the RDT control centre through a RAS connection object. Using 
Windows terminology, the RDT control centre represents a Remote Access Server (RAS server). This 
service is pre-installed in the Windows 2000 and Windows XP operating systems and only has to be 
configured in accordance with the installation instructions. 
 
DIA.NE message thus enters the messages originally generated by DIA.NE XT into a message database 
on the RDT control centre. This database (MS Access) is used as a basis for data on the functions of the 
DIA.NE control and DIA.NE report programs. 
 
In addition to the above, DIA.NE control can also receive the trend and logbook files recorded on the 
DIA.NE WIN server. 
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2.3.2 Notifying participants 
In order to make notification as efficient as possible, the messages received from plants are checked on 
the basis of various criteria before they are forwarded. The following criteria can be set: 
•  Plant password 
•  Plant number 
•  Module 
•  Message description 
•  Message number 
•  Message type 
•  Time at which message received 
•  Notification type (e-mail, SMS via e-mail, fax) 
 
The messages are transmitted to the configured participant using the MAPI interface (Microsoft Message 
Application Program Interface). The communication types available can be configured in the Microsoft 
mail profile: 
•  E-mail: 

Connection to a mail server or dial-up line to Internet provider 
•  Fax : 

Use of a MAPI-enabled fax server or the Microsoft Fax Service. 
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•  Voice: 
Voice participants (and/or pagers) can be notified by selecting the fax function (without transmitting 
data) 

•  SMS: 
Messages can be forwarded to pagers and mobile phones through the e-mail SMS gateway. Gateway 
services are provided by various mobile radio telephone suppliers or commercial service providers. 

 
The messages are generated in two different types: 
•  Short (for SMS):  

variable amount of message information 
•  Long (for e-mail and fax): 

all message information 
 
 

2.3.3 Main screen 
Following the call by DIA.NE control, the main screen is displayed. It shows the configured customer data 
("Customer name", "Address" and "Tel. No.") and the current status of the program. In this status field, all 
actions executed by the program at the time are shown, e.g. reading in transmitted messages, notifying 
participants etc. 
 
Last actions 
The Last actions table shows the activities of DIA.NE control.  
The table items are always arranged in reverse chronological order. The most recent entries can be found 
at the top of the table. The table is automatically updated.  
 
The Main screen contains two menu commands, i.e. File to access the other menus and Help to access 
the online help. 
 
 

2.3.4 File menu 

2.3.4.1 Caller 
This table shows which DIA.NE WIN servers (DIA.NE message) have called this RDT control centre and 
also displays the connection control status. 
When a connection between a new DIA.NE WIN server and the RDT control centre is established for the 
first time, a new item is entered into this table containing the plant data.  
 
Plant 
Name of the plant whose DIA.NE WIN server has called. 
 
Plant No. 
Plant number of the caller. 
 
Location 
Contents of the DIA.NE message address field. 
 
Last call 
Date and time of last call during which messages were saved. 
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Last message matching 
Date and time of last call during which "Non-Critical Messages" were transmitted (because of manual or 
automatic database matching by DIA.NE message). 
 
Last trend file matching 
Date and time of last call during which trend files were transmitted. 
 
Last report matching 
Date and time of last call during which report files were transmitted. 
 
Conn. monitoring 
If this check box is enabled, the entire line is displayed in red whenever connection monitoring is 
selected. This will typically be the case if more than 24 hours have passed between the current date and 
the “Last call” date.  
In that case, the Connection monitoring function in DIA.NE message should be enabled for this RDT 
control centre (see DIA.NE message documentation). 

2.3.4.2 Messages to be transmitted 
This table contains all the messages which have not yet been used to notify participants. 
 
In the table, certain messages can be excluded from notification by enabling the Already transmitted 
check box. The Delay check box enables temporary delay of notification for specific messages. 
 
Delay notification of participants 
Enabling this check box will delay all notification of participants. 

2.3.4.3 Export data 
DIA.NE control continuously receives messages from the DIA.NE WIN servers and stores these in the 
message database. This will increase the size of the database continuously, thus possibly adversely 
affecting the access speed in the longer term. If so desired, the user of the RDT control centre can store 
the increasing amount of data outside the current database. 
 
To relocate the message data, the Export data  dialogue box should be opened. 
 
Database 
Refers to current message database file. 
 
Oldest entry 
Date and time of oldest entry in this database. 
 
Most recent entry 
Date and time of most recent entry in this database. 
 
Number of entries 
The total number of entries in the message database. 
 
The following three steps can be taken: 
 
•  Export to database: The messages are exported to another Microsoft Access database in accordance 

with the "Export from date" and "Export to date" specified. If the destination database is not yet 
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available, it will be created after the user has been prompted (in conformity with file path and name in 
the text field concerned). If the database already exists, the messages to be exported will be added to 
it. 
Exporting the messages will not erase the contents of the message database! 

 
•  Delete: The messages will be permanently deleted from the message database (for example, following 

a prior export of data). 
 
•  Compact Database: Manually compresses the database. 

All database clients (e.g. DIA.NE report) must be closed first. 
 
This action is executed after clicking the OK button and acknowledging the warning. 
 
The Cancel button closes the whole dialogue box again. 

2.3.4.4 Message log book 
This menu command is used to view and delete the DIA.NE control log book. 
This log book contains DIA.NE control system entries. 

2.3.4.5 Configuration 
The DIA.NE control configuration window contains the following tabs: 

2.3.4.5.1 RDT control centre 
The customer data ("Customer name", "Address", "Tel. No.") of the RDT control centre are entered in this 
tab.  
 
Message protocols 
These settings enable automatic logging of all messages received in the last 24 hours. This will take 
place daily at the pre-set time (e.g. “16:00”) on the pre-selected printer. The text in the Free text for 
automatic protocols field will be printed in the heading of the message protocol. The printout contains all 
message information. Printout format: A4, landscape. 
 
Language* 
This field is used to select the language in which the message is to be printed (D, F, I, GB, etc.). This 
setting will not affect the communication language setting. 
 
Post office profile* 

The profile name should be entered in this field of the Microsoft mail profile which is to be used for 
communication. The profile name can be found in the Mail entry in Control Panel. 
 
Tip 
If Microsoft Outlook Express is used for sending messages (standard e-mail program), the entry 
in Post office profile is irrelevant. 

2.3.4.5.2 Standard messages 
This tab contains the DIA.NE XT / WIN standard messages.  
The entries in the table can be modified.  

                                                      
* Mandatory information! 
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The data in the table are set-up and maintained by GE Jenbacher. In combination with the Customer-
specific messages table, DIA.NE control adds a language-dependent text to the message numbers 
transmitted by the DIA.NE WIN server (DIA.NE message). 
 
Msg. No. 
Unique four-digit message number 
 
Language 
Language abbreviation (D, F, I, UK, etc.) 
 
Msg. Type 
Message type to which this message corresponds 
 
Description 
Text corresponding to this message number. 

2.3.4.5.3 Customer specific Messages 
The table contains customer-specific deviations from the standard message table. These deviations can 
arise if certain customers (plants, modules) have allocated an entirely different meaning to a certain 
message number as its standard meaning (typical cause of backup failures). In addition to the fields 
"Msg. No.", "Language", "Msg. Type" and "Description" as already contained in the Standard messages 
table, two additional fields are required for unique allocation to a module. 
 
Plant 
Number of the plant to which the exception applies. 
 
Module 
Number of the module to which the exception applies. 
 
If the plant or module field is left blank, the exception applies to all plants and/or modules. 

2.3.4.5.4 Notification 
Using DIA.NE control it is possible to inform the participants of any messages received. The participants 
to be notified are configured in this tab. 
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No.* 
Unique, freely selectable identification number. 
 
Enabled 
Enabled/Disabled communication participant 
 
Description* 
Freely selectable description of the participant to be notified. 
 
Address* 
E-mail or fax address of the participant to be notified (e-mail address or name of address book entry).  
 
Type* 
There are four communication types: 
•  SMS (e-mail to Internet SMS Gateway) 

Format: All message information can be freely configured and does not contain any special characters 
(see section 3.5.5). 

•  E-mail: All available message information is transmitted. The message is a text file. The lines are 
followed by CR+LF.  

•  FAX 
Format: All available message information is transmitted. The message is a text file. The lines are 
followed by CR+LF.  

•  Voice  
Nothing more than a call is placed to the participants. If no contact can be established, no failure 
message is transmitted! 

 
All other communication criteria are AND coupled (i.e. all conditions must be met). If a field is left blank, 
no check will be made for this criterion. 
 
Weekdays 
This field is used to indicate the weekdays on which the participant notification mode should be active 
(1=Monday, 2=Tuesday etc.). If you want to enter several days (e.g. "1, 2, 7"), these should be separated 
by commas. If nothing is entered, there is no time limit. 
 
Time from, Time to 
Used to enter the time range, during which the participant notification mode should be active. If nothing is 
entered, there is no time limit. 
 
Plant No. 
If the plant number of the message received matches the plant number configured here, the message is 
forwarded.  
 
Module No. 
If the module number of the message received matches the module number configured here, the 
message is forwarded. If you want to enter several modules (e.g. "1, 3, 5"), these should be separated by 
commas. 
 
 

                                                      
* Mandatory information! 
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Message No. 
Used to enter the message number at which this participant should be notified.  
 
Msg. Type 
If the message type of the message received corresponds to the message type configured here, the 
message is forwarded. If you want to enter several types (e.g. "A, W"), these should be separated by 
commas. 
 
Language* 
Used to enter the language (as country identification code, see section 3.5.1) in which the participant 
should be notified. 

2.3.4.5.5 SMS format 
This tab is used to configure the SMS format for the communication. 
 
The information to be transmitted may consist of the following database entries:  
•  Date & time of the message (from AMM) 
•  Plant 
•  Module number 
•  Message type 
•  Message text 
•  Plant number 
•  Module name 
•  Message number 
•  Date and time of message (entry in message database) 
•  Free text 
 
The contents of the "Free text" field consists of the "Subject" of the SMS message concerned. 

2.3.4.6 Password protection 
DIA.NE control is password protected against unauthorised access to its configuration. 
 
Logon: 
In order to be able to modify the configuration, the user has to log on. During the logon dialogue, the 
password must be entered. 
 
Logoff: 
Having modified the configuration, it is recommended that the user log off. This will protect the 
configuration from unauthorised access by third parties. 
 
Because the procedure for closing DIA.NE control is also password protected, the users have to log on 
before they can close the program. This is not required when closing Windows. 
 
During the password entry dialogue, the user has the option of changing the password. 
 
Caution: Following installation, the default password in the configuration is "6020". This password should 
be changed immediately when running the program for the first time. 
 

                                                      
* Mandatory information! 
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2.3.5 Help menu  

2.3.5.1 Help 
If you have any questions about DIA.NE control, you have an extensive Windows-type help function at 
your disposal in which all program elements are described in detail. 

2.3.5.2 About DIA.NE control 
This dialogue box will give you the copyright information and the program version. 
 
 
 

2.4 DIA.NE report 
DIA.NE report can be used to display and print the messages received in a RDT control centre on any 
number of processing stations (standard workstations). To that end, the workstations must be connected 
to the RDT control centre via a LAN. Both the language and the plants selected can be pre-set for the 
message display. 
 
In order to automate protocolling, all plant-specific messages received can be printed on a daily basis. 
Using DIA.NE report, manually compiled protocols can be printed at any time. 
 

2.4.1 Using the multi-user environment 
To enable DIA.NE report to be individually configured on several workstations, you should add the hash 
mark (#) and the workstation number to the DIA.NE report command line. 
 
Example: for station 1: C:\Program Files\diane\DianeReport.exe  #1 
  for station 2: C:\Program Files\diane\DianeReport.exe  #2 
  for station 3: C:\Program Files\diane\DianeReport.exe  #3 
  . . . 
 

2.4.2 Main screen 
Following the call by DIA.NE report, the main screen is displayed. This screen contains the configured 
customer data (“Customer name”), filter criteria and table view of the message data. 
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Received messages 
The Received messages table shows the messages that have been received from various DIA.NE WIN 
servers (DIA.NE message) in the RDT control centre’s message database.  
 
The table items are arranged in reverse chronological order. The order can be set using the Sort order 
field. The most recent entries can be found at the top of the table. The table is automatically updated 
and/or can be manually updated by pressing function key "F5" or choosing Refresh display from the File 
menu. 
 
Resetting 
New entries are displayed in bold type. Double-clicking on a line or pressing the Enter key will “quit” this 
message changing it to non-bold type. At the same time, the Quit check box is enabled. 
Once you have enabled “Quit”, you cannot disable it. 
 
From date / To date 
If so desired, the messages displayed can be chronologically filtered using the criteria From date and To 
date. This filter uses the AMM date on the message. 
 
No date limit 
Clicking this box will cancel the date limit. 
 
All messages 
DIA.NE report distinguishes between "Critical Messages" which are automatically transmitted to the RDT 
control centres on the basis of a pre-set condition in DIA.NE message, and "Non-Critical Messages" 
which are transmitted to the RDT control centre based on automatic or manual database matching. 
 
In general, DIA.NE report only displays "Critical Messages" in the Received messages table. If the All 
messages check box is enabled, the "Non-critical messages" are also displayed. 
 
Plant filter 
Selecting a specific plant reduces the message display to the selected plant. 
 
Sort order 
Select this to change the order in which messages are sorted. 
 AMM Date: Sorting based on the AMM date. 
 Chronological: Sorting based order in which messages (Nos.) are received. 
 
The Main screen contains two menu commands, i.e. File to access the other windows and Help to access 
the online help. 
 
 

2.4.3 File menu 

2.4.3.1 Refresh display 
This menu command is used to manually update the main screen display. 

2.4.3.2 Print 
This menu command is used to print all messages displayed on the main screen. 
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The Print options dialogue box contains the following tabs: 
 
Output 
This tab is used to select the output type. 
•  Printer: 

The Printer ... item is used to select the desired printer. 
•  File: 

The print output is converted into an ASCII file. The File ... item is used to select the desired path and 
file name. 

•  Print lines: 
This item is used to print the entire contents of the Received messages table, all the messages 
selected or just the current message. The selection is made on the left side of the Received messages 
table. 

 
Print to preview window first: 
If this check box is enabled, the item is displayed in the print preview window first before actually being 
sent to the printer. 
 
Print options 
•  Range: 

This option makes it possible to limit the number of pages to be printed. 
•  Frame: 

This option makes it possible to adjust the frame settings for the print layout. 
 
Row multiple line: 
This option enables a hard return to be entered in the output fields.  
 
Columns 
This tab allows you to select the message information to be used when printing. 
 
Fonts 
This item is used to select the font for headers and footers in order to modify the print layout. 
 
Click the Print button to start printing. 
If the Print to preview window first check box is enabled, a print preview window is opened before printing. 
 

2.4.3.3 Caller 
This table shows which DIA.NE WIN servers (DIA.NE message) have called this RDT control centre and 
also displays the connection control status. 
When a connection between a new DIA.NE WIN server and the RDT control centre is established for the 
first time, a new item is entered into this table containing the plant data.  
 
Plant 
Name of the plant whose DIA.NE WIN server has called. 
 
Plant No. 
Plant number of the caller. 
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Location 
Contents of the DIA.NE message address field. 
 
Last call 
Date and time of last call during which messages were saved. 
 
Last message matching 
Date and time of last call during which "Non-Critical Messages" were transmitted (because of manual or 
automatic database matching by DIA.NE message). 
 
Last trend file matching 
Date and time of last call during which trend files were transmitted. 
 
Last report matching 
Date and time of last call during which report files were transmitted. 
 
Conn. Monitoring 
If this check box is enabled, the entire line is displayed in red whenever connection monitoring is 
selected. This will typically be the case if more than 24 hours have passed between the current date and 
the “Last call” date.  
In that case, the Connection monitoring function in DIA.NE message should be activated for this RDT 
control centre (see DIA.NE message documentation). 

2.4.3.4 Configuration 
Because it is possible that a number of computers will be accessing the same message database using 
DIA.NE report, the DIA.NE report configurations for every workstation are stored separately. This enables 
a user-defined DIA.NE report environment for every workstation. 

2.4.3.4.1 General 
Number of days displayed* 
This field limits the number of messages shown in the Received messages  table to a maximum number 
of days. 
 
UNC path to database* 
If DIA.NE report is to display the contents of a message database, its path (on the RDT control centre) 
should be entered here. 
 
Database local to computer: 
  "<Drive>:\<DIA.NE RMC program directory >" e.g. C:\Program Files\diane 
Database on network computer: 
  „\\<Computer name>\<Share>“   e.g. \\RDTCentre_1\diane 
 
Message protocols 
These settings enable automatic logging of all messages received in the last 24 hours. This will take 
place daily at the pre-set time (e.g. “16:00”) on the pre-selected printer. The text in the Free text for 
automatic protocols field will be printed in the heading of the message protocol. The printout contains all 
message information. Printout format: A4, landscape. 
 

                                                      
* Mandatory information! 
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Language* 
This field is used to select the language used for displaying or printing a message (D, F, I, GB, etc.). 

2.4.3.4.2 Display 
Plants displayed 
This table is used to enter the plants to be displayed. If the table is left empty, no messages will be 
displayed. 
 
The plants to be displayed can be selected from the Plant combo box. This makes all known plants 
(plants which are actually connected) available.  
 
Visible fields 
In these fields, the message information to be displayed in the Received messages table of the main 
screen can be selected. Information not visible in the main screen cannot be printed. 

2.4.3.5 Help menu  

2.4.3.6 Help 
If you have any questions about DIA.NE report, you have an extensive Windows-type help function at 
your disposal in which all program elements are described in detail. 

2.4.3.7 About DIA.NE report 
This dialogue box gives you the copyright information and the program version. 
 
 
 

2.5 DIA.NE message 
DIA.NE message is installed on the plant’s DIA.NE WIN servers. This program transmits messages and 
data to DIA.NE control in the RDT control centres. 
 

2.5.1 Transmission of messages 
All the messages generated by the module are logged by a program on the DIA.NE WIN server (alarm 
logger). These operational messages (B), warnings (W) and trip messages (A) are written to files and 
further processed by DIA.NE message.  
 
In order to transmit the messages more efficiently, the messages on the modules are checked first 
against various criteria before being transmitted.  
 
The following criteria can be set: 
•  Module No. / Module name 
•  Message No. / Description 
•  Message type 
•  Weekdays 
•  Time of appearance 
 
If a message is classified as being a “Critical message”, the plant name, plant number, module 
identification and module number are added to it, after which the message is automatically transmitted to 
the RDT control centres configured. 
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TIP 
Changing date and time on the modules and the DIA.NE WIN server can result in duplicated 
transmissions or ‘gaps’ in the database of DIA.NE control. 
 
 

2.5.2 Failed connection to modules 
If the messages logged by DIA.NE message cannot be loaded, DIA.NE message generates a special 
warning message. 
 
The warning message contains the following items: 
•  Description:  Module inaccessible 
•  Message No.:  0001 
•  Message type:  W 
 
 

2.5.3 File transmission 
Historical measurement data and logbook data are cyclically logged and stored in files on the DIA.NE 
WIN servers.  
 
The files stored on the modules can be transmitted both manually and automatically to any RDT control 
centre by DIA.NE message. 
 
 

2.5.4 Main screen 
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When DIA.NE message starts up, the main screen is displayed. It shows the configured plant data 
("Customer name", "Address", "Tel. No.", "Plant" and "Plant number") and the current status of the 
program. In this status field, all actions executed by the program at the time are shown, e.g. checking the 
log files, transmitting messages etc. 
 
Last actions 
The Last actions table shows the activities of DIA.NE message.  
The table items are arranged in reverse chronological order. The most recent entries can be found at the 
top of the table. The table is automatically updated. 
 
The Main screen contains two menu commands, i.e. File to access the other windows and Help to access 
the online help. 
 
 

2.5.5 File menu 

2.5.5.1 Database matching with RDT control centre 
Database matching with RDT control centres is used to transmit all messages which have not been 
configured for auto alarm activation ("Non-critical messages"). It can also be used to transmit trend and 
logbook files. Besides manual data matching, it is also possible to configure automatic data matching. 
 
A combo box will appear from which the desired RDT control centre must be selected. Data matching can 
be limited by using the From date and To date text box. 
Click the Select button to initiate the transfer. 
 
Transmission to the following RDT control centre: 
From the list of all configured RDT control centres, one specific centre can be selected. RDT control 
centres are defined using the identification and the RAS profile name. 
 
From date / To date: 
The date range for messages yet to be transmitted is automatically entered in these text boxes. If the 
date range is extended, DIA.NE message will read out the required messages from the modules. 
Following successful completion of this procedure, data transmission to the RDT control centre is started. 

2.5.5.2 Message log book 
This menu command is used to view and delete the DIA.NE message log book. This log book contains 
DIA.NE control system entries. 

2.5.5.3 Configuration 
The DIA.NE message configuration window contains the following tabs: 

2.5.5.4 Plant data 
This item is used to enter the plant data ("Customer name", "Address", "Tel. No.", "Plant" and "Plant 
number") of the DIA.NE WIN server ("Customer name" and "Plant number" are mandatory!). 
 
Ring buffer capacity 
This value indicates the length of time that “Non-critical messages“ are to remain stored in the DIA.NE 
message database. 
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Scan interval for modules 
The scan interval is used to determine the frequency with which DIA.NE message searches for new 
messages. Zero means as quickly as possible. 
 
Number of messages displayed 
The value entered indicates the number of items in the Last actions table. A maximum of 200 items can 
be displayed. If the pre-set number is exceeded, the oldest item is overwritten again. 
 
Language 
This field is used to select the language in which message text is displayed (D, F, I, GB, etc.). 
 
Closing Interval 
 
Tip 
This function only applies to modem servers with DIA.NE plants and must not be activated on 
DIA.NE WIN servers!!! 
 
Activating this field and indicating a time shuts down the program in a controlled manner. Together with 
the Power off program installed on the modem server, this achieves a controlled re-boot of the modem 
server. 
In the Days field, the shutdown procedure can be limited to specific days (1=Monday, 2=Tuesday, etc.). If 
you want to enter several days (e.g. "1, 2, 7"), these should be separated by commas. If no specific day 
has been entered, there is no limitation (= every day). 

2.5.5.5 Modules 
This item is used to enter the plant modules. The following fields can be filled for each of the modules: 
 
Scan* 
Clicking on this field will activate or deactivate the search for new messages per module. 
 
Description* 
The engines are identified as follows: 
 Module M01 = JES_01 
 Module M02 = JES_02 
 etc. 
 
Module * 
The module number corresponds to the engine number. 
 
UNC path* 
The UNC path indicates the directory structure through which DIA.NE message can reach the log files  
e.g.  DIA.NE WIN server for DIA.NE XT / WIN plants: "C:\log\M01" 
 Modem server for DIA.NE plants: \\jes_01\c-drive\log 

2.5.5.6 RDT control centres 
This tab is used to enter all RDT control centres to be notified by DIA.NE message. 
 

                                                      
* Mandatory information! 
 



 

Keyword: Standard Unit no.: J Module no.:  

Module type : JMS XXX GS Version:  Engine no.:  

Issued: TEE/Brunner, Überegger Checked: Engineering Date: 2004-08 
 Hermes 2 00_EN.doc Index: Version 2.00 Page - No.: 23 / 37 

Remote Data Transfer

 EN 

No. 
The program will issue a running number. 
 
Row 
This item is used to indicate the sequence in which the RDT control centres are to be notified. 
 
Backup only 
If one of the RDT control centres cannot be reached, another RDT control centre (backup) to be notified 
can be defined here. 
 
Description* 
Free description of the RDT control centre. 
 
Enabled* 
If one of the RDT control centres cannot be reached temporarily, this item is used to deactivate the 
release. All messages received in the meantime will be held back and will be transmitted after the release 
is reactivated. 
 
RAS profile 
Name of the RAS connection object through which the connection to the RDT control centre should be 
established (Control Panel - Settings - Network and Dial-up connections). If the RDT control centre is 
directly coupled to the DIA.NE WIN server via a LAN (LAN connection option), this field must be left 
blank. 
 
Conn. Monitoring 
If the connection control is activated, a special operational message is transmitted to the RDT control 
centre (watchdog). This message is transmitted when no message has been transmitted for the last 23 
hours. 
 
The operational message contains the following items: 
•  Description: Connection Monitoring 
•  Message No.: 0000 
•  Message type: B 
•  Module number: 0 
 
UNC path* 
Path on the RDT control centre where the message database is stored.  
This setting must match the setting on the RDT control centre. 
Default: "\\<Workstation name>\<Share>" e.g. \\Computer_1\diane 
 
Last status 
Last status of the DIA.NE WIN server (communication with RDT control centre successful or 
unsuccessful). The status is automatically updated when the window is opened. 
 
Weekdays 
Used to indicate the weekdays on which messages should be transmitted to a RDT control centre  
(1=Monday, 2=Tuesday etc.). If nothing is entered, there is no time limit. If you want to enter several days 
(e.g. "1, 2, 7"), these should be separated by commas. 
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Time from, Time to 
Time within which the messages received should be transmitted to a RDT control centre. If nothing is 
entered, there is no time limit. In order to activate a transmission, both a weekday and a time from/to 
should be entered 
 
Backup 1 
If it is not possible to transmit any messages, you can specify a backup centre here which is to be 
notified. The figure indicated under Number should be entered (see first column). 
This backup centre will not be used during manual or automatic data matching. 
Backup 2 
If messages cannot be transmitted to the first backup centre either, a second backup centre can be 
defined here. 
 
Data matching - Time 
This field is used to enter the exact time at which the automated data matching with the RDT control 
centres should be carried out. 
 
Data matching - Days 
The data matching operation defined under Time can be limited to certain weekdays (1=Monday, 
2=Tuesday, etc.). If you want to enter several days (e.g. "1, 2, 7"), these should be separated by 
commas. 

2.5.5.7 Transmitted message 
This tab is used to enter the criteria for those messages which are to be classified by DIA.NE message as 
messages to be transmitted ("Critical Messages"). 
 
For a functional configuration, at least one module reference (“Description” or “Module number”) or one 
message reference (“Message text”, “Message number” or “Message type”) must be entered! 
 
Module No. 
A combo box is used to enter information. Click the drop-down button to select the configured modules 
from a list (see 3.3.2). If the module number of the received message matches the number entered here, 
the message is classified as a message to be transmitted (“Critical Message”). If the box is left blank, no 
check will be made for this criterion (meaning that for all plant modules the corresponding message will 
be transmitted if the message type and message number match). When the drop-down button is used to 
make a selection, the module name will be entered into the Module field automatically. 
 
Mod. name 
Name of the module selected in the Module No. field. 
 
Description 
A combo box is used to enter information. Click the drop-down button to select a specific message from 
the list. The list is in sorted alphabetically. Selecting a text will automatically cause the “Msg. No." and 
“Msg. Type” to be entered into the corresponding lines. 
 
Msg. No. 
If the message number matches the number indicated here, the message is classified as a message to 
be forwarded (“Critical Message”). If the field is left blank, no check will be made for this criterion. A 
combo box is used to enter information. Click the drop-down button to retrieve a specific message from 
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the list. The list is sorted numerically. Selecting a text will automatically cause the “Description” and “Msg. 
Type” to be entered automatically in the corresponding cells. 
 
Msg. Type 
If the message type corresponds to the letters entered here (e.g. A = trip, W = warning, B = operational 
message), the message is classified as a message to be forwarded ("Critical Message”). If the field is left 
blank, no check will be made for this criterion. If only the message type is entered without the message 
number, this means that all messages of this type will be classified as messages to be forwarded. 
Multiple input in the “A, W” format is valid. 
 
Weekdays 
The message is checked for a weekday. The numbers 1 through 7, representing Monday through Sunday 
respectively, can be entered (e.g. 1=Monday, 2=Tuesday, etc.) in this field. If the field is left blank, no 
check will be made for this criterion. If you want to enter several weekdays (e.g. "1, 2, 7"), these should 
be separated by commas. In order to have the message forwarded, the weekday requirement must be 
fulfilled. 
 
Time from, Time to 
If the time stamp of the message received falls within the pre-set “Time from / Time to” range, the 
message is classified as a message to be forwarded ("Critical Message"). If a field is left blank, no check 
will be made for this criterion. In order to have the message forwarded, the “Time from/Time to” 
requirement must be fulfilled. 

2.5.5.8 Data matching 
This tab is used to establish which files are to be transferred in the course of the automatic data matching 
process. 
 
The following data can be transferred. 
•  Messages: These are all messages which have not yet been transmitted ("Non-Critical Messages"). 
•  Trends: These are files that contain historical measurement data. The file name may be freely 

selected and can contain wildcards (*, ?) (e.g. *.mdb). 
The files are stored at the RDT control centre in the directory ..\<Plant number>\<Module no>\LOG. 

•  Reports: These are files that contain log book data. The file name may be freely selected and can 
contain wildcards (*, ?) (e.g. *.xml). 
The files are stored at the RDT control centre in the directory ..\<Plant number>\<Module no>\REP. 

 
RDT Centre No. 
If you enter a RDT control centre in this field, the configuration line will be restricted to the specified RDT 
control centre. 

2.5.5.9 Messages registered 
This table contains all the messages received from the modules which still have to be transmitted to 
DIA.NE control. 
 
Delay transmission of messages to RDT control centres 
Activating this option will stop transmission of all messages to the RDT control centres. All messages 
received in the meantime will be stored and will be forwarded after the transmission is reactivated. 

2.5.5.9.1 Password protection 
DIA.NE control is password protected to prevent unauthorised access to its configuration. 
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Logon: 
In order to be able to modify the configuration, the user has to log on. During the logon dialogue, the 
password must be entered. 
 
Logoff: 
Having modified the configuration, it is recommended that the user log off. This will protect the 
configuration from unauthorised access by third parties. 
 
Because the procedure for closing DIA.NE control is also password protected, the users have to log on 
before they can close the program. This is not required when closing Windows. 
 
During the password entry dialogue, the user has the option of changing the password. 
 
Caution: Following installation, the default password in the configuration is "6020". This password should 
be changed immediately when running the program for the first time. 
 
 

2.5.6 Help menu  

2.5.6.1 Help 
If you have any questions about DIA.NE message, you have an extensive Windows-type help function at 
your disposal in which all program elements are described in detail. 

2.5.6.2 About DIA.NE message 
This dialogue box will give you the copyright information and the program version. 
 
 
 

2.6 Installation instructions – configuration instructions 
This section describes how to configure the network connection between the DIA.NE WIN client and the 
DIA.NE WIN server to access the DIA.NE WIN application. 
 
It also describes how to install and configure the DIA.NE RMC application on the server and client. 
 
 

2.6.1 Configuring a RDT network connection between a DIA.NE WIN client and server (modem option 
only) 
A RDT network connection is used to establish a TCP/IP network connection between the DIA.NE WIN 
client and DIA.NE WIN server through which data are transferred to the DIA.NE WIN application. 
 
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
 
Windows 2000 
•  Open the Network and Dial-up Connections folder in Control Panel 
•  Select Make New Connection and use the wizard to create a new connection 
•  After the welcome message select Dial-up to private network in the Network Connection Type 

dialogue box. 
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•  In the next dialogue box, select the desired modem for incoming calls. 
•  In the Phone Number to Dial dialogue box, type in the telephone number of the desired DIA.NE WIN 

server. 
•  In the next dialogue box you can choose whether to allow all users of this computer or only the current 

user to use the RDT connection. 
•  In the last dialogue box you can assign a name to the connection. 
•  Once the connection object has been created, double-click the object to open it. 
•  In the dialogue box that now appears, click the Properties button to go to the properties side of the 

connection. 
•  Select the Options dialogue box and, in the Idle time before hanging up field, set the time after which 

the RDT connection itself hangs up and no more data should be transported. 
•  Go to the Networking dialogue box and select the Internet Protocol (TCP/IP) component. 
•  Click the Properties button to go to the properties side and click the Advanced… button to open the 

advanced settings. 
•  Uncheck the Use default gateway on remote network check box. 
•  Close all dialogue boxes by clicking OK. 
 
Windows XP 
•  Open the Network Connections folder in Control Panel  
•  Select Create a new connection and use the wizard to create a new connection 
•  After the welcome message select Connect to the network at my workplace in the Network Connection 

Type dialogue box. 
•  In the next dialogue box, select Dial-up connection and continue with the wizard. 
•  Type in the desired name for the connection under Connection Name. 
•  In the Phone Number to Dial dialogue box, type in the telephone number of the desired DIA.NE WIN 

server and click Finish in the wizard. 
•  Once the connection object has been created, double-click the object to open it. 
•  In the dialogue box that now appears, click the Properties button to go to the properties side of the 

connection. 
•  Select the Options dialogue box and, in the Idle time before hanging up field, set the time after which 

the RDT connection itself hangs up and no more data should be transported. 
•  Go to the Networking dialogue box and select the Internet Protocol (TCP/IP) component. 
•  Click the Properties button to go to the properties side and click the Advanced… button to open the 

advanced settings. 
•  Uncheck the Use default gateway on remote network check box. 
•  Close all dialogue boxes by clicking OK. 
 
When you have established the RDT network connection, start the DIA.NE WIN client in accordance with 
DIA.NE WIN Online Documentation. 
 
When you have finished working on the DIA.NE WIN application, you should disconnect the RDT network 
connection as soon as possible for cost reasons. 
 
If you have any queries or problems, please contact the GE Jenbacher Competence Centre! 
 
 

2.6.2 Configuring a network connection between a DIA.NE WIN client and server (LAN option only) 
A GE Jenbacher service engineer will configure the network connection between the DIA.NE WIN client 
and the DIA.NE WIN server when the plant is being commissioned.  
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Information required from the customer (desired configuration): 
•  IP address of the DIA.NE WIN server (default: 172.31.200.100) 
•  Subnet mask of the network (default: 255.255.0.0) 
•  Default Gateway of the network (default: 172.31.1.1) 
•  IP address of the customer’s computer (suggestion: 172.31.1.1 / 255.255.0.0 / 172.31.200.100) 

 
 

2.6.3 Configuring an Internet connection between a DIA.NE WIN client and server (Internet option only) 
If the plant is to have an Internet connection, the DIA.NE WIN client computer must likewise have an 
Internet connection. This can be either a dial-up or broadband connection (DSL) to the Internet service 
provider (ISP) or a central Internet access point in any company network. 
 
The Internet access point must provide at least the following services (protocols): 
•  http (web access) 
•  HTTPS (encrypted web access) 
 
The actual configuration of the Internet access must be performed by the customer and cannot be 
supported by GE Jenbacher because of the wide variety of provider and network configurations. 
 
The GE Jenbacher Competence Centre will be pleased to assist with any general questions on Internet 
access. 
 
 

2.6.4 Configuring the DIA.NE WIN server 
DIA.NE message is pre-installed as standard on every DIA.NE WIN server. 
The program can be configured either by the GE Jenbacher Competence Centre or by the customer. 
 
In order to carry out the configuration at the DIA.NE WIN server, the DIA.NE WIN server must be 
controlled remotely by remote maintenance software. 

2.6.4.1 Remote maintenance of the DIA.NE WIN server 
To configure the DIA.NE WIN server, a network connection (TCP/IP) must be established with the 
DIA.NE WIN server (via modem, LAN or the Internet).  
A VNC Remote Control Session, which is used for the remote control of the DIA.NE WIN server, can be 
established through this connection. 
 
The VNC program (i.e. the VNC viewer) can be obtained from the manufacturer’s website 
http://www.realvnc.org or from the GE Jenbacher web server 
http://www.jenbacher.com/dianewin/download.htm. 
The VNC software is covered by the GNU General Public Licence and is therefore free of charge. 
 
When the software starts, type in the IP address of the DIA.NE WIN server as the destination and a 
password. The address will depend on the connection type selected and its configuration. 
 
Default: via modem:  10.200.200.200 
  via LAN:  172.31.200.100 
 
The password for the VNC connection must be requested from the GE Jenbacher Competence Centre. 
 
If you have any queries or problems, please contact the GE Jenbacher Competence Centre! 
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2.6.4.2 Configuring DIA.NE message 
•  Open the Configuration dialogue box  
•  The Plant Data form is displayed. 
•  Type in the data for the first form (minimum information: Plant, Plant number) 
•  Go to the Modules form 
•  Activate the desired modules by enabling the Scan check box and verify the UNC paths 
•  Go to the RDT control centres form 
•  Configure the RDT control centres (minimum information: “Row“, “Description“, “RAS profile“ (modem 

connection only, the field remains blank for network connection!), “UNC path“, “User name“, 
“Password“, “Enabled“ and “Conn. Monitoring“) 

•  Go to the Transmitted message form 
•  Configure the desired messages to be transmitted (minimum information: “Msg. No.“ or “Msg. Type“) 
•  Optional: Go to the Data matching form 
•  Optional: Configure the desired data for database matching 
•  Click the OK button to exit the configuration dialogue box  
•  If using the modem connection option: Configure the RDT network (see next point). The connection 

object must have the same name as specified in the “RAS profile“ field in the RDT control centres 
configuration dialogue box. 

 
If you have any queries or problems, please contact the GE Jenbacher Competence Centre! 

2.6.4.3 Configuring the RDT network (modem option only) 
A RDT network gives a computer access to enabled resources (drives) on a workstation (RDT control 
centre with DIA.NE control database), even if it is not on the same network. In this case, the workstation 
you select must be equipped with a modem and configured as a RAS server. 
 
Set-up procedure 
•  Open the Network and Dial-up Connections folder in Control Panel 
•  Select “Dummy“ and make a copy of the connection using Create Copy in the File menu 
•  Rename the new object using Rename in the File menu.  

TIP! The name of the connection object must be identical to the name of the “RAS profile” in 
the DIA.NE message configuration! 

•  To change the connection object to the desired RDT control centre, double-click the object to open it. 
•  In the dialogue box that now appears, click the Properties button to go to the properties side of the 

connection. 
•  Change the telephone number to the RDT control centre you want to select (Phone number field), and 

if necessary select the modem to be used from the Connect using field. (ISDN, GSM, etc.) 
•  Confirm the configuration dialogue and click Cancel to close the connection object. 

2.6.4.4 Configuring the network connection for the RDT control centre (LAN option only) 
The configuration of the network connection from the DIA.NE WIN server to the customer’s computer 
(RDT control centre or DIA.NE WIN client) must be carried out by a GE Jenbacher service engineer. This 
configuration is identical to setting up the network connection to use the DIA.NE WIN client as described 
in the section on Configuring a network connection between a DIA.NE WIN client and server (LAN 
option only) 
 
Information required from the customer (desired configuration): 
•  IP address of the DIA.NE WIN server (default: 172.31.200.100) 
•  Subnet mask of the network (default: 255.255.0.0) 
•  Default Gateway of the network (default: 172.31.1.1) 
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•  IP address of the customer’s computer (suggestion: 172.31.1.1 / 255.255.0.0 / 172.31.200.100) 
•  TIP! The IP address of the customer’s computer is derived from the UNC path in the DIA.NE 

message configuration for this RDT control centre: \\<IP Address>\<Share> 
(e.g. \\172.31.1.1\diane) 

 
 

2.6.5 Installing/configuring the RDT control centre  
 
TIP 
The software can only be installed if the user has 
LOCAL ADMINISTRATOR RIGHTS. 
The user must also be familiar with the operation and maintenance of Windows 2000/XP and with 
the installation of software packages. 
 
The customer must prepare the computer as follows for the installation of the RDT control centre (DIA.NE 
control plus DIA.NE report): 
•  Windows 2000 Workstation or Windows XP Professional must be installed 
•  The most recent service packs including all the most recent patches must be installed 
 
If, to divide the load, several modems are to be set up to answer incoming calls, Windows 2000 Server or 
Windows Server 2003 will be required!  
If this is the case, please contact the GE Jenbacher Competence Centre! 
 
If using the modem connection option: 
•  install the modem, including the connection to the telephone line 
 
If using the LAN connection option: 
•  install the network card and configure the TCP/IP networks between the DIA.NE WIN server and the 

DIA.NE WIN client 
 
Optional: 
•  Install an additional network for the shared use of DIA.NE report 
•  Set up an e-mail account to forward messages by e-mail/SMS 
 
The customer must prepare the computer as follows for the installation of a separate computer for 
DIA.NE report: 
•  Windows NT 4.0, Windows 2000 Workstation or Windows XP must be installed 
•  The most recent service packs including all the most recent patches must be installed 
•  Network access to the RDT control centre must be provided (by installing the network card and 

configuring the network) 
 
The software installation can be broken down into the following steps: 
•  Installing the software 
•  Configuring the software: 
•  Creating the dial-in user 
•  If using the modem connection option: Configuring the dial-up services (Remote Access Services, 

RAS) 
•  Enabling the drive resource 



 

Keyword: Standard Unit no.: J Module no.:  

Module type : JMS XXX GS Version:  Engine no.:  

Issued: TEE/Brunner, Überegger Checked: Engineering Date: 2004-08 
 Hermes 2 00_EN.doc Index: Version 2.00 Page - No.: 31 / 37 

Remote Data Transfer

 EN 

2.6.5.1 Installing the DIA.NE control and DIA.NE report software  
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
 
The software is installed using the installation CD-ROM supplied. Insert the CD-ROM into the drive and 
run the "Setup.exe" program. 
Alternatively, all the installation software can be downloaded from the GE Jenbacher web server. 
Information on the links to be used can be obtained from the GE Jenbacher Competence Centre. 
 
The installation procedure is interactive. 
The installation option RDT Control Centre installs the DIA.NE control and DIA.NE report programs. 
Choose the installation option Custom to install a separate computer for DIA.NE report. This installs the 
DIA.NE report program only. 
 
You can cancel the installation at any time. You can also remove the software you have installed by 
uninstalling the relevant program with the Add/Remove Programs function in Control Panel. 
 
Please note that, following dia.ne control installation, the password is initialised using ‘6020’. 

2.6.5.2 Configuring DIA.NE control 
•  Run DIA.NE control 
•  Choose Login from the File menu to complete the login procedure. 

Default password: 6020 
(Otherwise, it is not permitted to edit the configuration!) 

•  Choose Configuration from the File menu to adjust any settings. Choose Notification to configure 
automatic message forwarding by e-mail/SMS via e-mail/fax. 

If you have any queries or problems, please contact the GE Jenbacher Competence Centre! 

2.6.5.3 Configuring DIA.NE report 
•  Run DIA.NE report 
•  As soon as the program starts, a text box appears in which you have to type the path to the DIA.NE 

control database. 
 - Database on local computer (RDT control centre): 
 <LW>:\<Installation directory>  e.g. C:\Program Files\diane 
 - Database on remote computer 
 \\<Workstation name>\<Release name> e.g. \\computer-1\diane 
•  Choose Configuration from the File menu to adjust any settings. Choose Display to select the plants 

which are to be displayed. 
 
If you have any queries or problems, please contact the GE Jenbacher Competence Centre! 

2.6.5.4 Creating the dial-up user 
A special user must be created to allow the DIA.NE WIN server (DIA.NE message) to access the RDT 
control centre. 
 
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
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Windows 2000 
•  Open the Users and Passwords dialogue box in Control Panel 
•  Click the Add… button and use the wizard to add a new user. 
 User name: hermesrmc 
 Full Name: <any> 
 Description: <any> 
 Password: 041097 
 Access Level: Standard User (Power User) 
•  In the Users and Passwords dialogue box, go to the Advanced form and click the Advanced button in 

the Advanced User Management section. 
•  Select Users and double-click the new user “hermesrmc“ to open it. 
•  Set the user properties as follows: 
 User must change password at next logon: DISABLED 
 User cannot change password: ENABLED 
 Password never expires: ENABLED 
 Account is disabled: DISABLED 
 Account is locked out: DISABLED 
•  Confirm the dialogue and close all the dialogue boxes. 
 
Windows XP 
•  Open the User Accounts dialogue box in Control Panel 
•  Click the Create a new account button and use the wizard to add a new user. 
 Account name: hermesrmc 
 Account Type: Limited 
•  Select the new user to create the password. 
•  Choose the Create a password menu command and specify the following password: 041097 
•  Confirm the dialogue and close all the dialogue boxes. 
•  Open the Performance and Maintenance dialogue box in Control Panel 
•  Open Administrative Tools 
•  Open Computer Management 
•  Select the Users subgroup in Local Users and Groups and double-click the new user “hermesrmc“ to 

open it. 
•  Go to the Member Of configuration dialogue box. 
•  Click the Add… button to add the user to the Power Users group (Add… – Advanced – Find now). 
•  Confirm the dialogue and close all the dialogue boxes. 
 
Tip 
User names and passwords may only be changed in close consultation with GE Jenbacher, as 
any unannounced change will result in data connection problems! 

2.6.5.5 Configuring the Remote Access Service (RAS) 
(modem option only) 

By configuring a RAS server you allow remote computers (DIA.NE WIN servers) to access resources ( file 
releases; DIA.NE control database) in the local computer. 
 
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
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Windows 2000 
•  Open the Network and Dial-up Connections folder in Control Panel 
•  Select Make New Connection and use the wizard to create a new connection 
•  After the welcome message, select Accept incoming connections in the Network Connection Type 

dialogue box. 
•  In the next dialogue box, select the desired modem for incoming calls.  
•  In the Incoming Virtual Private Connection dialogue box, leave the Do not allow virtual private 

connections option unchanged. 
•  Select the user “hermesrmc“ in the next dialogue box, Allowed Users. 

If this user does not appear in the selection, cancel the wizard and perform the previous step 
“Creating the dial-up user”! 

•  In the next dialogue box, “Networking Components”, the following components must be enabled: 
- Internet Protocol (TCP/IP) 
- File and Printer Sharing for Microsoft Networks 
- Client for Microsoft Networks 

•  Select Internet Protocol (TCP/IP), go to Properties and enable the following setting: 

 
•  In the last dialogue box you can assign a name to the connection. 
 
Windows XP 
•  Open the Network Connections folder in Control Panel  
•  Select Create a new connection and use the wizard to create a new connection 
•  After the welcome message, select Set up an advanced connection in the Network Connection Type 

dialogue box. 
•  In the Advanced Connection Options dialogue box, select Accept incoming connections. 
•  In the next dialogue box, select the desired modem for incoming calls. 
•  In the Incoming Virtual Private Network (VPN) Connection dialogue box, leave the Do not allow virtual 

private connections option unchanged. 
•  Select the user “hermesrmc“ in the next dialogue box, User Permissions. 

If this user does not appear in the selection, cancel the wizard and perform the previous step 
“Creating the dial-up user”! 

•  In the next dialogue box, Networking Software, the following components must be enabled: 
- Internet Protocol (TCP/IP) 
- File and Printer Sharing for Microsoft Networks 
- Client for Microsoft Networks 
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•  Select Internet Protocol (TCP/IP), go to Properties and enable the following setting: 

 
•  Close the wizard. 
 
As soon as the connection is created, the RAS service is active and accepts incoming modem 
connections. 

2.6.5.6 Enabling the drive resource 
To be able to access the drives of a workstation which is configured as a RAS server, you must enable 
the relevant drive or directory. 
 
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
 
Windows 2000 
•  Open Explorer and go to the folder containing the DIA.NE control program directory (default: „diane“) 

(e.g. “C:\Program Files“) 
•  Select the program folder and choose Sharing … from the File menu. 
•  Select Share this folder in the dialogue box. 
•  Click the Permissions button to set the access rights. 
•  In the dialogue box that now appears, click the Remove button to remove the group “Everyone“. 
•  Click the Add… button to add the DIA.NE dial-up user “hermesrmc“. 
•  In Permissions, give the user the right to “Change“. 
•  Confirm and close all dialogue boxes. 
 
Windows XP 
•  Open Explorer 
•  Choose Folder Options… from the Tools menu. 
•  Go to the View configuration dialogue box and disable the Use simple file sharing (Recommended) 

option in Advanced Settings. 
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•  Close the dialogue box. 
•  Go to the folder containing the DIA.NE control program directory (default: „diane“) (e.g. “C:\Program 

Files“) 
•  Select the program folder and choose Sharing and Security … from the File menu. 
•  Select Share this folder in the dialogue box. 
•  Click the Permissions button to set the access rights. 
•  In the dialogue box that now appears, click the Remove button to remove the group Everyone. 
•  Click the Add… button to add the DIA.NE dial-up user “hermesrmc“. (Add… – Advanced – Find now) 
•  In Permissions, give the user the right to “Change“. 
•  Confirm and close all dialogue boxes. 
 
After you re-boot the PC, the DIA.NE WIN server (DIA.NE message) is authorised to access the DIA.NE 
control database. 

2.6.5.7 Automatic start-up of DIA.NE control 
To enable DIA.NE control to automatically start up when re-booting or logging off/on, there must be a 
shortcut to DIA.NE control in the All Programs - Startup folder. 

2.6.5.8 Automatic login to the RDT control centre when re-booting 
Follow the steps below to ensure you can log in automatically after the RDT control centre has been re-
booted. 
 
TIP 
To complete the following steps, users must have 
LOCAL ADMINISTRATOR RIGHTS! 
 
Windows 2000 
•  Open the Users and Passwords folder in Control Panel 
•  Select the desired auto-login user from the user list. 

(To do this, the check box Users must enter a user name and password to use this computer must be 
enabled.) 

•  Disable the check box Users must enter a user name and password to use this computer. 
•  Click the OK button to close the dialogue box. Confirm the next password request by typing the 

password in twice. 
 
Windows XP 
•  Open the Users and Passwords folder in Control Panel 
•  Select the desired auto-login user from the user list. 

(To do this, the check box Users must enter a user name and password to use this computer must be 
enabled.) 

•  Disable the check box Users must enter a user name and password to use this computer. 
•  Click the OK button to close the dialogue box. Confirm the next password request by typing the 

password in twice. 
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3. Connections 

3.1 Modem 
A telephone line via the public telephone system is used as the medium for connecting the plant to the 
customer. 
The connection from the customer (client) to the DIA.NE WIN server (server) is established for the 
“remote control” application. This is reversed for the “automatic data and message transmission“ 
application. 
 
By default, an analogue modem to the internationally approved V90/V92 standard is used in the plant. 
Customers can use any commercially available analogue modem. 
 
Maximum attainable connection speed: 56 KBit/s 
 
An alternative option would be to fit the plant with an ISDN adapter or a GSM modem (dual band 
900/1800). 
 

3.2 Network (LAN) 
An Ethernet network connection is used as the connection medium between the plant and the customer. 
 
Cabling: Twisted-Pair (TP) cables (at least CAT 5) 
Maximum cable length: 100 m (extension by means of additional on-site network components (repeater, 
hub, etc.) is possible) 
Network protocol: TCP/IP 
 
Maximum attainable connection speed: 100 KBit/s 
 

3.3 Internet 
A permanent Internet connection is used as the connection medium between the plant and the customer. 
 
Because of the high risks involved in connecting the plant to the Internet, a security plan has been drawn 
up which satisfies the most stringent security criteria in the IT sector. 
 
Tip! 
Because of the high security risk (economic criminals, hackers, etc.) connecting the plant directly 
to the Internet is not permitted under any circumstances and will result in the loss of guarantee 
and warranty rights! 
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3.3.1 Construction 

 

 
 

3.3.2 Preconditions 
 
This connection option requires a permanent Internet access point in the plant and additional security 
devices. 
 
Descriptions of the exact scope of supply and the exact on-site services are available from the 
GE Jenbacher Sales Department or the GE Jenbacher Competence Centre. 
 
 

3.3.3 Access to the plant 
 
A general description of possible options for accessing the plant via the Internet (via Remote Access 
Portal, direct, etc.) is in preparation. 
 
If you have any questions, please contact the GE Jenbacher Competence Centre. 
 
 
 
 


